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     Solution of Q.P. Code 33276 T.Y.B.Com Computer systems and Applications Semester VI 
75/25 held on April 12, 2018   

         
Note: 1) All questions carry equal marks and are compulsory. 
           2) Figures to the right indicate maximum marks for a question.  
            
Q1.  (A)  Attempt  any two  sub-questions from a), b) and c) in MS-EXCEL 

(True or False) 
(2) 

  a) The size of chart can be changed. T 
  b) A template has the file name extension .XLTX T 
  c) A workbook can contain maximum three worksheets.  F 
     
 (B)  Attempt  any two  sub-questions  from d), e) and f) in VISUAL BASIC 

(Multiple Choice) 
(2) 

  d) In a VB project, the form design is carried out in the _______________.  
   1) Properties 2)Tool Box 3) Project Explorer 4) Form Window  

  e) Visual Basic controls are ________.  
   1) code 2) part of  the menus 3) rules 4) objects  
  f)  __________ is a valid object name for a text box.  
   1)TxtClass 2)Txt  Class 3) Txt+class 4)TextClass  
     
 (C)  Attempt any six  sub-questions from g), h), i), j), k), l), m), n), o) in  

E-Commerce. (True Or False). 
(6) 

  g) Traditional commerce is more reliable than E-Commerce.  T 

  h) Non-repudiation refers to non-denial of E-commerce transactions.  T 

  i) Portals earn revenue from advertising and referral fees. T 

  j) Encryption is a process of converting cipher text to plain text. F 

  k) Integrity in E-Commerce ensures that data is not altered during 
transmission. 

T 

  l) In E-Commerce only credit cards can be used for making payments. F 

  m) In public Key encryption there is only one key. F 

  n) Hacking of credit cards and password is possible in E-Commerce. T 
  o) Digital cash is the electronic parallel of notes and coins. T 
     
 (D)  Attempt any five  sub-questions from p), q), r), s), t), u), v), w) in E-

Commerce. (Multiple Choice) 
(5) 

  p) A Computer to Computer exchange of business transaction is called ______.  
   A) E-Business B)Super Market C)EDI D)E-Market  
  q) In __________ E-Commerce the consumers deals with each other.   
   A) C2C B) B2C C) B2B D) C2B  
  r) It is a convention that all sites that use SSL connection while making a 

secure connection use _____________instead of HTTP. 
 

   A)SMTP B)HTTPS C)FTP D)TCP/IP  
  s) The most commonly used form of payment in E-Commerce is __________.  
   A) Credit Card B) PayPal C) Petro Card D) Digital Cash 
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  t) In online stored value systems, cards that have embedded chips that store 
personal information is called _______________. 

 

   A)Debit Card B)Smart Card   C)Credit Card D)Ideal card  
  u) The full form of WAP in E-Commerce is Wireless ___ Protocol.                
   A)And B)App C)Application D)Area  
  v) The full form of HTTP in E-Commerce is Hyper Text _________Protocol.  
   A) Travel B) Topology C) Transmit D) Transfer  
  w) The full form of P2P in E-Commerce is _________.  
   A) Peer to Peer B) Person to Person C) Peer to Person Person to Peer  
     
Q2. (A)  Answer any one sub-question from a) and b) in E-Commerce. (8) 
  a) Explain the features of E-Commerce. 

(Give full marks if any four features are explained, 2 marks for each feature) 
ANS: The important features of E-Commerce as listed below. 
Ubiquity: 
When we say that E-Commerce is ubiquitous, it means that it is available 
just about everywhere and at any time. It removes the boundaries of space 
and makes it possible to shop from the confines of your home or office and 
even when travelling by various modes of transport. Hence it liberates the 
market from any physical space that we normally associate with carrying 
out commerce. 
Global Reach: 
E-Commerce technology permits commercial transactions to cross various 
cultural boundaries, as well as the geographical boundaries that have been 
made by mankind across the globe. Hence the size of the market that is 
available for E-Commerce includes the entire population which is going 
online.  
Universal Standards: 
The technical standards used in E-Commerce are universal standards i.e. 
they are used all over the world. This is chiefly due to the fact that the 
technical standards used in the internet are universal standards, which are 
accepted and shared all over the world.  
The use of these universal standards in E-Commerce has resulted in a great 
reduction in the costs involved in searching for products, as they can be 
viewed by one and all.  
Interactivity: 
 The technologies used in E-Commerce are interactive i.e. they allow a two 
way communication between the parties involved in the transaction, which 
are the merchant making the sale and the buyer. For example, a website 
may ask the consumer to fill in a form and depending on the data entered in 
that form, various options are displayed, from which the consumer can 
choose the appropriate one.  
Richness: 
Richness refers to the complexity and content of information on a product, 
which is traded in E-Commerce. Using audio and video the richness of the 
information that is given is greatly enhanced. This, in turn, becomes a 
powerful tool for selling in the commercial environment. 
Information Density. 
Information density refers to the total amount and quality of information 
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that is available to all the stakeholders (market participants, consumers and 
merchants). The wide use of E-Commerce has greatly reduced the cost of 
collection of information, its storage, processing and communication.  
Personalization. 
This enables the merchants and traders to have better information of the 
requirements in the market, due to which they can modify their marketing 
strategies. Due to the interactive nature of technology used in E-Commerce, 
the past preferences and behavior of the user is known. This enables 
merchants to customize i.e. give the product or service as desired by the 
user. 

  b) Explain any four Revenue models in Ecommerce. 
(2 marks for each model maximum 8 marks) 
ANS:The following are the major types of revenue models: 
1. Advertising Revenue Model. 
In this model websites which attract a lot of hits (number of people who 
visit this website) offer advertisement space on their pages for a fee. Such 
websites are widely sought after and earn high revenue from 
advertisements. Most of these websites are offering users content, services 
and/or products. Such websites are popular and hence become a good place 
for any business to advertise their products and get noticed. 
2. Subscription Revenue Model 
In this model the Company charges the users a subscription fee for having 
access to the material, offering it has on its website. Those who subscribe to 
this website are given a username and password using which they can 
access the website. Generally the subscription fee is valid for a certain 
period of time only.  
A Company’s website which offers daily tips to traders on the share market 
is one example of such a model.  
3. Transaction Fee Revenue Model 
In the Transaction Fee Revenue Model, a company charges a fee for the 
transaction it carries out. The fee amount depends on the number and size 
of the transactions. An example of such a model is websites that allow 
online auction facilities. Most of these websites charge a small fee when the 
item is sold. An example of this is ebay.com.  
4. Sales Revenue Model 
In the Sales Revenue Model companies obtain revenue by selling various 
products, information or services to its customers. Websites that market 
products and build sales revenue from merchandising belong to this model. 
For this the website has to build a brand of its own. An example of this is 
Amazon.com which is one of the popular sites for purchasing books. 
5. Affiliate Revenue Model    
In the Affiliate Revenue Model companies send business to an affiliate and 
receive a suitable fee which could be a flat fee, or even a percentage of the 
revenue generated. They also earn revenue by offering incentives for the 
transaction that take place. This is done by offering potential customers 
special deals. When the customers take advantage of this and make any 
purchase, they earn point which can be redeemed against various gift items. 
The company benefits from the fee it receives for sending the business to 
the affiliate. An example of this is mypoints.com 
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 (B)  Answer any one sub-question from c) and d) in E-Commerce (7) 
  c) Explain any four advantages of E-Commerce.  

(Any four points are explained give full marks) 
ANS: Some of the important advantages of E-Commerce are 

.          Reduced time per transaction. 

• Reduced cost to buyers. 

• As orders are processed electronically errors in transactions are reduced. 

• Reduced cost to the traders as the orders are obtained online. 

• Even in remote areas new markets are easily created. 

• Better quality achieved due to product standardization. 

• Optimization of resource utilization. 

• Lower inventory costs to the traders. 

• Lower advertising costs. 

• Equal opportunity for big and small merchants. 

 

 

  d) Explain SET protocol. 
ANS: The Secure Electronic Transaction (SET) is a protocol developed by 
Visa and Master Card to full proof the online Credit Card transactions and to 
provide security in terms of Confidentiality, Integrity and Authenticity of the 
transaction.  
The main features of SET protocol are as follows: 
1. In a SET protocol all the sensitive information sent between the 
customer, the merchant and the merchant’s bank is encrypted. 
2. All the above three parties have to get themselves authenticated by the 
SET certificate authority.  
3. The customer’s credit card number is never seen by the merchant. 
SET covers all the aspects of online commerce. It authenticates the 
identification of the parties involved in the transaction by using a 
combination of cryptography system along with digital certificates.   

 

      
Q3. (A)  Answer any one  sub-question from  a) and b) in MS-EXCEL (8) 

 
  a) Consider the following worksheet 

 A B C D E 

1 NAME DEPARTMENT BASIC SALARY DA HRA 

2 SUNITA IT 85000   

3 BINA SALES 75000   

4 PRAKASH ACCOUNTS 50000   

5 JAY HR 65000   

6 NITIN SALES 35000   

7 REENA ACCOUNTS 28000   

Write steps to obtain 

i) DA as 125% of the Basic if Basic is more than 40,000 otherwise 110% of the 

Basic in column D. 

ii) HRA as 24% of the Basic whenever Basic is below 30,000 otherwise 20% of 

the Basic in column E. 
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iii) Find number of cells where the Department is ‘SALES’ in cell C10. 
  ANS: 
(i) To compute DA. 
1. Select D2 and type the formula 
     =IF (C2>40000, C2*125%, C2*110%) and press enter. 
2. Select D2 and drag the fill handle to D7. 
 (ii) To find HRA. 
1. Select E2 and type the formula  
      =IF (C2<30000, C2*24%, C2*20%) and press enter. 
2. Select E2 and drag the fill handle to E7. 
(iii) Find number of cells where the Department is ‘SALES’ in cell C10. 
1. Select C10 and type  
       =COUNTIF (B2:B7,”SALES") and press enter.  

  Marks 3+3+2  
  b) The following data has been entered in a worksheet. 

 
 A B C D 
1 NAME SALES AMOUNT DISCOUNT NET PRICE 
2 SAMIRA 50000   
3 SAIRA 60000   
4 NASIR 20000   
5 NITIN 30000   
6 SARITA 100000   
7 ADIL 75000   

Write steps to  
i) Calculate Discount in column C using the following Discount  
Policy. 

Sales Amount Rate of Discount 
First   25,000    6% 
Next   25,000    9% 
 Excess  12% 

                ii) Calculate Net Price in column D  
               (Net Price = Sales Amount –Discount). 
ANS: 
DISCOUNT 
1. Select C2 and type 
=IF(B2<=25000,B2*6%,IF(B2<=50000,25000*6%+(B2-
250000)*9%,(B2-50000)*12%+25000*9%+25000*6%))and press enter. 
2. Select C2 and drag the fill handle to C7. 
NET PRICE 
1. Select D2 and type =B2-C2 and press enter. 
2. Select D2 and drag the fill handle to D7. 

Marks 6+2 
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 (B)  Answer any one  sub-question from  c) and  d) in MS-EXCEL 
 

(7) 

  c) The following data has been entered in a worksheet. 

 A B C D E F G 

1 PRODUCT QUANTITY PRICE TOTAL COST  PRODUCT PRICE 

2 OIL 1    LUX 45 

3 KITKAT 4    DOVE 50 

4 TEA 1    PEARS 44 

5 SUGAR 2    HAMAM 25 

6 PEARS 5    DETTOL 35 

7 NESCAFE 6    LIRIL 40 

8      KITKAT 20 

9      NESCAFE  78 

10      TEA 110 

11      SUGAR 60 

12      OIL 125 

 

Write steps to find the Price in column C using VLOOKUP function. Table to 
be referred for finding the Price per unit is given in the range F2:G12. Also 
find Total Cost in Column D. 
(Total Cost = Price * Quantity) 
ANS: 
i)To find Price  

1. Select C2 and type the formula 
       =VLOOKUP(A2,$F$2:$G$12,2,FALSE) 

2. Select C2 and drag the fill handle to C7. 
ii)To  find Total Cost 
1.  Select D2 and type =B2*C2 and press enter 
2.  Select D2 and drag the fill handle to D7. 

Marks 5+2 

 

     
  d) Consider the following worksheet 

 A B C D E F 

1 ROLL NO. TEST1 TEST2 TEST3 AVERAGE RESULT 

2 A44 56 49 55   

3 A54 76 87 65   

4 A58 74 70 70   

5 A60 87 54 67   

6 A61 35 40 36   

Write steps to  
                 i) Calculate Average marks in column E. 
                 ii) Find  the result in Column F , where result is  “Pass” when  
                      Average marks are 40 or more otherwise “Fail”. 
                iii) Find number of students whose Average marks are more than       
                      or equal to 70 in cell E8.   
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ANS: 
i)Average Marks: 

1. Select E2 and type =AVERAGE (B2:D2) and press enter. 
2. Select E2 and drag the fill handle to E6. 

ii) Result: 
1. Select F2 and type  
       =IF (E2>=40,”PASS”,”FAIL”) and press enter. 
2. Select F2 drag the fill handle to F6. 

iii)   
1. Select E8 and type  

            =COUNTIF (E2:E6,”>=70") and press enter.   
Marks 2+3+2               

     
Q4. (A)  Answer any one  sub-question from  a) and b) in MS-EXCEL 

 
(8) 

  a) The following data is entered in a worksheet regarding the stocks during 
January, February and March. 
 

 A B C D E 
1 ITEM JAN FEB MAR TOTAL 
2 PENCIL 4000 4200 4500  
3 PEN 3000 3000 3100  
4 NOTE BOOK 2000 1800 1800  
5 WRITING PAD 1000 1100 1200  

 
Write steps to 
 i) Find the total stock of each product in the cells E2, E3, E4 and E5. 
ii) Create 3-D Bar chart for the data. 
iii) Create a Pie chart for the month of March. 
iv) Create a Line diagram for Jan and March. 
i) Find the total stock in each month in the cells E2 to E5. 
          1. Select E2 and type  
          =SUM (B2:D2) OR =B2+C2+D2 and press enter. 
          2. Select E2 and drag the fill handle to E5. 
ii) To create Bar chart for the data. 

1. Select the data A1:E5 (or B2:E5). 
2. From the Insert tab, select bar chart, then select sub type 3-D. 

iii) To create Pie chart for the month of March. 
1. Select the data D1:D5  
2. From the Insert tab, select Pie chart, then select any sub type. 

iv) To Create a Line diagram for the stock in Jan and March. 
1. Select the data B1:B5 and D1:D5  
2. From Insert Tab select Line and then select any Sub type.   

                                                                                                         Marks 2+2+2+2 
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  b) The following table shows Quantity, Cost Price per unit (CPRICE) and 
Selling Price per unit (SPRICE).  
 

 A B C D E F G 

1 PODUCT QTY CPRICE SPRICE  COST SALES PROFIT 

2 PRODUCT 1 200 100 123    

3 PRODUCT 2 240 75 120    

4 PRODUCT 3 430 28 60    

5 PRODUCT 4 120 45 70    

6 PRODUCT 5 320 40 55    

7 PRODUCT 6 230 50 65    

8 PRODUCT 7 250 65 80    

9 TOTAL PROFIT       

 
Write steps in Excel to calculate Cost in column E, Sales in column F, Profit 
in column G and Total Profit in G9 respectively.  Write steps in Excel using 
Solver to find what the cost per unit should be in order to achieve the Total 

Profit of `75,000.  

(COST= QTY*CPRICE 
 SALES=QTY*SPRICE  
 PROFIT =SALES-COST) 
ANS: 
i) COST 
1. Select E2 and type =B2*C2 and press enter. 
2. Select E2 and drag the fill handle to E8. 
ii) SALES 
1. Select F2 and type =B2*D2 and press enter. 
2. Select F2 and drag the fill handle to F8. 
iii)PROFIT 
1. Select G2 and type =F2-E2 and press enter. 
2. Select G2 and drag the fill handle to G8. 
iv) TOTAL PROFIT 
1. Select G9 and type =SUM (G2:G8) and press enter. 
v) SOLVER 

1. Select G9 and from the Data Tab select Solver. 
2. In the dialog box in the ‘Set objective’ option the cell G9 is already  

              selected. 
3. In the ‘To’ option select ‘Value of’ and type 75000 in the text box. 
4. In the option ‘By Changing Variable cells’ text box enter C2:C8 
5. Then click on Solve. When Solver will obtain the result, click on ok.                          

                                                                                                     Marks 1+1+1+1+4 
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Q4. (B)  Answer any one  sub-question from  c) and d) in MS-EXCEL (7) 
  c) The following data has been entered in a worksheet 

 A B C D 

1 SNO NAME CITY SALES AMOUNT 

2 S001 AJAY MUMBAI 35000 

3 S002 POOJA PUNE 55000 

4 S003 AJIT MUMBAI 42000 

5 S004 JAY BANGALORE 50000 

6 S005 RITA PUNE 52000 

7 S006 SAMIR MUMBAI 75000 

8 S007 NEHA BANGALORE 60000 

 
Write steps to do the following:- 

i) Display only those rows where the City is ‘Bangalore’.                     
iii) Display only those rows where Sales Amount is below average Sales       
Amount. 
ii) Display only those rows where the Sales Amount is more than                      

`48,000 but less than ` 70,000. 

ANS: 
i) Display only those rows where the City is ‘Bangalore’. 
  1. Select the data A1:D8 
  2. From DATA Tab select Filter. 
  3. Click on the drop down arrow of City and from text filter select  
       ‘equals’. 
  4. Type ‘Bangalore’ in the dialog box and click on ok. 
iii) Display only those rows where Sales Amount is below average Sales  
        Amount.        
  1. Select the data A1:D8. 
  2. From DATA Tab select Filter. 
  3. Click on the drop down arrow of Sales Amount and from number          
       filter select ‘below average’. 
ii) Display only those rows where the Sales Amount is more than 48,000  
      but less than 70,000. 
  1. Select the data A1:D8. 
  2. From DATA Tab select Filter. 
  3. Click on the drop down arrow of Sales Amount and from number  
        filter select ‘greater than’. 
  4. Type 48000 in the dialog box and then select ‘And’. 
  5. Select ‘Less than’ 
  6. Type 70000 and click on ok.     
                                                                                                                Marks 3+2+2 
(Give full marks irrespective of the order in which students write the 
answers.)  
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  d) Explain the following functions in MS-EXCEL. 
   

1) DATE( ) 2) COUNTBLANK( ) 3) LARGE( ) 4) NOW( ) 
5) SMALL( ) 6) MONTH( ) 7) WEEKDAY(  ) 

 
 

ANS:  
(Give 1 mark if either definition or example or syntax is correct for each 
function) 
1. DATE (year, month, day): Returns the date in American format. 
e.g. = DATE (2016, 11, 16) gives 11/16/2016.  
2. COUNTBLANK (range): Counts the number of empty cells in a specified 

range of cells. 

e.g. COUNTBLANK (D1:D5) gives 3 if there are only two values in the cells 

from D1 to D5. 

3. LARGE (array, k): Returns the k
th 

 largest value in the data set 

     e.g. = LARGE({45,23,67,87},3) gives 45 the 3
rd

 largest value.  

4. NOW( ):  Returns the current system date and time.  
     e.g. 6/3/2014 11:48 

5. SMALL(array, k): Returns the k
th 

 smallest value in the data set 

     e.g. = SMALL({45,23,67,87},3) gives 67 the 3
rd

 smallest value  
6. MONTH (serial number): Returns the month corresponding to a serial 
number or date text. The month returned has a value from 1 to 12. 
e.g. =MONTH(“3-JUNE-2015”) gives 6 
7. WEEKDAY(serial_number, return_type): Returns the day of the week 
corresponding to a date. The day is given as an integer, ranging from 1 
(Sunday) to 7 (Saturday), by default. 
e.g. =WEEKDAY(“4/13/16”) gives 4 

 

     
Q5. (A)  Answer any one  sub-question from  a) and b) in VISUAL BASIC 

(Note: Students can use text box or message box for output. Both are correct. 
In text box .TEXT is optional.)  

(8) 

  a) Write a project in VB to design a suitable form which allows the user to 
enter a number and calculate and display whether the number is divisible 
by 7or not. 
Object Property Value  

Form Name frmCheck 

 Caption Check 

Label  Name lblNum1 

 Caption Number1  

Text Box Name  txtNum 

 Text “  “  (blank) 

Command Box Name  cmdCheck 

 Caption &Check 

Command Box Name cmdExit 

 Caption &Exit 

(4 Marks) 
Private sub cmdCheck_Click( ) 

Dim N As Integer 

N = Val(txtNum) 
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If N Mod 7 = 0 Then 

MsgBox “Number is divisible by 7”, vbOKonly 

Else 

MsgBox “Number is not divisible by 7”, vbOKonly 

End If 

End Sub 

(3 Marks) 

Private Sub cmdExit_Click( ) 

End 

End Sub 

(1 Mark) 
 

  b) Write a project in VB to design a suitable form which allows the user to 
enter Name and Basic Salary and calculate Bonus as 45% of Basic Salary 
whenever basic salary is less than 25000 otherwise 40% of Basic Salary 
using a ‘Calculate’ button and display the result.  
 

OBJECT PROPERTY VALUE 

Form Name FrmBonus 

 Caption Bonus 

Label 1 Name LblName 

 Caption NAME 

Label 2 Name LblBasicSal 

 Caption BASIC SALARY 

Label 3 Name LblBonus 

 Caption BONUS 

Text Box 1 Name TxtName 

 Text (Blank) 

Text Box 2 Name TxtBasicSal 

 Text (Blank) 

Text Box 3 Name TxtBonus 

 Text (Blank) 

Command Button 1 Name CmdCalculate 

 Caption CALCULATE 

Command Button 2 Name CmdExit 

 Caption EXIT 

(4 Marks) 

         

         Private Sub CmdCalculate_click()                                     
Dim BS,B as Single 

BS=Val(TxtBasicSal) 

If BS<25000 Then 

B=BS*.45 

Else 

B=BS*.40 

End If 

TxtBonus=FormatNumber(B,2) 

End Sub 

(3 Marks) 
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         Private CmdExit_click()                                                 
End 

End Sub 

(1 Marks) 

         OR 

 

           Private Sub cmdCalculate_Click()                                                 
           If val(txtBasicSal)<=25000 Then 
           txtBonus = val(txtBasicSal)*.45 
           Else 
           txtBonus = val(txtBasicSal)*.40 
           End If 
           End Sub 

(3 Marks) 
           Private Sub cmdExit_click()                                                           
           End 
           End Sub                                                                                                      (1 Mark) 

     
Q5. (B)  Answer any one  sub-question from  c) and d) in VISUAL BASIC (7) 
  c) Write a project in VB to design a suitable form which allows the user to 

enter length of a side of a square and then calculate and display area and 
perimeter of the square. 
(Area= Side*Side 
Perimeter= 4*Side) 

OBJECT PROPERTY VALUE 

Form Name FrmSquare 

 Caption Area & Perimeter 

Label 1 Name LblSide 

 Caption LENGTH 

Label 2 Name LblArea 

 Caption AREA 

Label 3 Name LblPerimeter 

 Caption PERIMETER 

Text Box 1 Name TxtSide 

 Text (Blank) 

Text Box 2 Name TxtArea 

 Text (Blank) 

Text Box 3 Name TxtPerimeter 

 Text (Blank) 

Command Button 1 Name CmdCalculate 

 Caption CALCULATE 

Command Button 2 Name CmdExit 

 Caption EXIT 

( 3 Marks) 
                        Private sub cmdCalculate_Click( ) 

  Dim S As Integer 

  Dim Area As Single 

              Dim Perimeter as Single  
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  S = Val (txtSide) 

  Area = S * S 

                        Perimeter=4*S 

             txtArea = FormatNumber(Area, 2) 

                        txtPerimeter = FormatNumber(Perimeter, 2) 

  End Sub 

(3 Marks) 

                      Private Sub cmdExit_Click( ) 

                      End 

                         End Sub 
          (1 Mark) 

                      OR 

                   Private Sub cmdCalculate_Click()             

                   txtArea = val(txtSide)*val(txtSide) 

                   txtPerimeter= 4*val(txt.side) 

                   End Sub 

(3 Marks) 
                         Private Sub cmdExit_Click( ) 

           End 

                         End Sub 
(1 Mark) 

  d) Write a project in VB to design a suitable form which allows the user to 
enter an integer and calculate and display the factorial of that integer when 
the “Calculate” button is clicked. 
(Factorial of N= 1*2*3----------*N) 
 

Object Property Value/Setting 

Form Name FrmFact 

 Caption Factorial 

Label 1 Name lblNum 

 Caption Number 

Text box1 Name TxtNum 

 Text “ “ (blank) 

Command Name CmdFact 

 Caption &Calculate 

Command Name CmdExit 

 Caption E&XIT 

 (3 Marks) 

Private Sub CmdFact_Click()                        

Dim i, n, fact  as Integer 

n = Val(Txtnum1) 

fact=1 

For i=1 to n step 1 

fact= fact* i 

Next  i 

MsgBox “Fact = “ &fact, vbOKOnly 

End Sub 

(3 Marks) 

Private Sub CmdExit_click()                        
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End 

End Sub 

(1 Mark) 
 


